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Customizing Class Names and Adding Class
Descriptions

The gradebook includes view-only details about each class you
teach, such as the course name, course number, section number,
period, term, start date, end date, and associated grade scale. Add
more details about the class, such as a description or the syllabus,
that will be visible in the PowerSchool Student and Parent Portals,
and in PowerSchool Mobile.

Also customize the name of the class if you prefer to use a nhame
that is different from the course name. For example, if you teach
multiple Biology classes, customize the names to be different from
each other. Custom class names will appear only in your
gradebook. Co-teachers, students, and parents will not see them.

To customize a class name and add a description:
1. At the top of the gradebook window, select a class

2. In the upper-right corner, select the term in which the class
meets, if different from the current term, or select all terms

3. Click Settings

4. Select Class Descriptions

The details pane for the selected class opens.

5. To customize the name of the class, enter the name in the
Custom Class Name field
Once you click Save, the custom class name will appear in
the gradebook automatically.

6. Enter the class description, syllabus, or other details in the
Class Description field
Use the editing bar to style the description.

7. Click the arrow to the left of another class name to open the
details pane and add a custom name or description

8. Click Save

Setting Up Display Preferences

Customize the display settings to control how class names appear
in your gradebook—by period and day or by section number.
Additionally, define whether or not to show standards and
traditional grades.

To set up display preferences:
1. Click Settings
2. Select Display Settings

3. Open the "Display and Sorting" menu and select an option,
such as Section Number (sort by Course/Custom
Name), to change the way class names appear

When you choose to sort class names by course name or
custom name, classes will be sorted by their course names,
unless you've entered custom class names on the Class
Descriptions page. In that case, classes will be sorted by
their custom names.

4. Check Show Traditional Grades to display traditional
grades in the gradebook

5. Then from the “Values to Show in the Traditional Grade
Column” menu, select the types of grades you want to see,
such as Grade, Percent, and Points

6. Check Show Standards Pages and Links to use the
standards grading features in the gradebook

7. Check Show Standards on Assignments to show
standards aligned to assignments in the gradebook
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8. To make the auto-calculation of standards scores from
assignments scores the default setting when you create a
new assignment, choose New Assignments Start
Checked from the “Auto-Calculate Assignment Standards
Scores Initial State” menu

Making this selection will cause the “Auto-Calculate
Assignments Standards Scores” check box to be selected by
default when you create an assignment. To view the setting
when creating a new assignment, navigate to the Standards
tab, select the standards that are aligned to the
assignment, and click the Show Selected Standards tab.

9. To change the sort order of the Traditional and Standards
navigation links in the Grading menu and Quick Menu, open
the Navigation Links Sort Order menu and choose
Standards, Traditional

The default setting is Traditional, Standards.

10.To display the Professional Judgment Indicator on the
Standards and Standards Progress pages, check Show on
Grading: Standards and Show on Students: Standards
Progress

11.Under Student Names, use the Display menu to define how
students’ names will appear in the gradebook, such as by
first, then last name

12.Use the “Sort Students by” menu to choose how to sort the
lists of students, such as by first name

13.To view new students’ names at the bottom of class lists,
check Add newly enrolled students to the bottom

14.To conceal the names of pre-registered students from class
lists, check Hide pre-registered students

15.Click Save

Changing the Display Text Size

PowerTeacher Pro is designed so that you can see multiple
students or assignments in a compact view by default. However,
you can zoom in by changing the text size.

To change the size of the text:
1. Click your name in the upper-right corner

2. Under View, select Medium or Large

To decrease the text size to the default size, select Small.

Setting Up Grading Preferences

Administrators may choose to set up the grading preferences at
the district or school level for all teachers. However, if they are
permitted to do so by their district and school leaders, teachers
may define some of the grade calculations for the classes they
teach. Provided you have permission to do so, set up the grade
calculations for one class. Then save time by copying the
traditional grade calculations across classes and reporting terms.

Additionally, administrators may make alternate grade scales
available for teachers and administrators to assign to individual
students. If you have permission to do so, assign alternate grade
scales to students who need to be graded using a grade scale
that's different from the scale assigned to the class. For example, a
student may have an IEP that specifies the use of an alternate
grade scale.

To define a traditional grade calculation for a class:
1. Click Settings
2. Select Traditional Grade Calculations

3. To see the grade calculations for all of the classes, click
Expand All
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12.

13.

14.

1.
2.

For one of the classes in the list, click the Edit icon next to
the first reporting term

. To calculate the overall class grade using the formula, verify

that Calculate Overall Class Grade is checked

Open the Type menu and choose a calculation type, such as
Category Weighting

Open the Attribute menu and select a category, such as
Homework

To define the weight of the selected category, enter a value
in the Weight field, such as 2 (for 20%)

. To include another category, click the + sign
10.
11.

Open the Type menu and choose Category Weighting

Open the Attribute menu and select a different category,
such as Quiz

To define the weight of the selected category, enter a value
in the Weight field, such as 3 (for 30%)

Repeat steps 9-12 to set up weighting for two more
categories

Use weight values that will make the values in the Percent
columns add up to 100%.

To save the grade calculation, click Save

Set up the grade calculations for the remaining reporting
terms. If you do not have access to edit the grade
calculation preferences, follow your school and district
policies or contact your PowerSchool administrator.

To define standards grade calculations:

Click Settings

Select Standards Grade Calculations

7.

Define how standards grades will be calculated from
assignment scores by default, for example, choose Most
Recent Scores

Define the number of recent scores to include in the
calculation and their relative weighting by clicking the Edit
icon, choosing the number of scores, and modifying the
values in the Weight column

. To automatically calculate higher-level standards grades

from lowest-level standards grades, check Auto-Calculate

Select the metric that will be used in the calculation, such
as Mean

Click Save

To copy traditional final grade calculations:

1.
2.
3.

Click Settings
Select Traditional Grade Calculations

In the upper-right corner of the Traditional Grade
Calculations page, click the gear icon

Select Copy Traditional Grade Calculations

. At the top of the Copy Final Grade Calculations window,

select Within A Class to copy the settings from one
reporting term to another within the same class

In the From area, open the Class menu and choose the
class from which you want to copy the calculations

In the From area, open the Reporting Term menu and
choose S1 as the term from which you want to copy the
calculations

In the To area, open the Reporting Term menu and choose
S2 as the term to which you want to copy the calculations

If you are changing traditional grade calculation settings for
the target class and want to recalculate any existing grades,
check Recalculate Final Grades.
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9. Click Validate copy

10. Review the summary to ensure that you are copying the
correct settings, then click Copy
The alert at the top of the window indicates that the
settings were copied successfully.

To assign an alternate grade scale to an individual student:
1. Click Settings
2. Click Student Grade Scales

3. Locate the section the student is enrolled in and click the
arrow next to the section name

4. To add a student grade scale, click Add

From the Choose Grade Scale menu, select the alternate
grade scale

Check the box to the right of the student's name
Click Save

8. To confirm the change, click Save Changes

New assignment scores that you enter for the student will
be based on the alternate scale. To update previously
entered scores, recalculate final grades by following the
steps for recalculating final grades in this document.

9. On the Student Grade scales page, view, modify, or remove
grade scales assigned to individual students

Note: When a student has been assigned an alternate grade
scale, the Scoresheet will include a gold triangle in the
name cell for that student.

STUDENTS (25) GRADE
1. BISHOP, Donovan 3 92.25%
2. BLACK, Perisa B 86.75%

@

3. CAMPBELL, Butler 85.91%

Working with Assignments

Before you begin creating assignments, it's recommended that you
create categories so you can group assignments by type. Then, set
up assignments in the gradebook, choose whether or not to include
them in students' final grades, and tie them to standards. Your
district leaders may also set up assignment categories at the
district level for you and other teachers to use.

Creating Categories

Categories are broad classifications in which you group similar

types of assignments. Examples of categories are homework, tests,

and quizzes. Set up your own categories, or use district-created

categories. District-created categories are identified by an icon that

looks like a school house next to the category name.
Categories

Show Inactive

ORDER

Q
(@]
=
(@]
)

CATEGORY NAME CLASSES USING ACTIVE EDIT

v . Classwork & AllClasses (17-18) v V4

AV . Project #& AllClasses (17-18) v /

AV . Quiz & AllClasses (17-18) v V4

AV . Test #& AllClasses (17-18) v /

A v . Group Project #& All Classes (17-18) \/ ‘/

AV . Homework All Classes (17-18) v /
Legend

Icons ¢& District created category

To create an assignment category:
1. Click Create
2. Select Category
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10.

11.

12.

13.

14.

15

16.

On the Category tab, open the Select Classes menu and
select the class or classes in which you will use the category
By default, the category is available to all classes.

Enter the name of the category, such as Test

Select a color for the category, such as Red

Use the default status of Active

Check Inactive when you want to make categories that you
no longer use inactive.

Enter a description of the category, such as Use for test
assignments

Click the Assignment Defaults tab

Select the default score type that assignments in this
category will use, such as Points

To include extra points in the assignments by default, click

Extra Points and enter the number of extra points, such as
5

To weight assignments in this category by default, click
Weight and enter a value, such as 2, in the Weight field

In the Score Entry Points field, enter the number of points
that assignments in this category will be worth by default,
such as 100

Use the Publish Assignment menu to define when
assignments in this category will be published

To publish the scores of assignments in this category by
default, verify that Publish Scores is selected

.To include assignments in this category in final grade

calculations by default, verify that Count in Final Grade is
selected

To save the new category, click Save

Creating and Viewing Assignments

View assighments on both the Assignments and Scoresheet pages.
Set up assignments at the beginning of a school term or at any
time during the term. To save time, duplicate existing assignments
or create duplicates while creating a new assignment.

To create an assignment:

1.
2.

g N o Ul R

10.

11.
12.

13.

Click Create
Select Assignment

Open the Select Classes menu and select a class

Click outside the Select Classes menu to close it.

Enter the name of the assignment, such as Unit 1 Test
Select Test as the category

Select a score type, such as Points

Enter the number of score entry points, such as 80

To include the assignment in students’ final grades, verify
that Count in Final Grade is selected

Enter the assignment due date

The default due date is today’s date.

Enter a description, such as This test covers all of the
topics in Unit 1

Click the Students tab

Verify that the assignment applies to all students

To apply the assignment to a selection of students, click
Add/Remove Students. Then clear the check box next to
the Filter area and check the boxes next to the selected
students’ names.

Click the Standards tab
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14.
15.
16.

17.

18.

Select the standards that are aligned to the assignment
Click the Publish tab

Open the Publish Assignment menu and choose when to
publish the assignment for students and parents

To publish students’ scores once you‘ve scored the
assignment, check Publish Scores

Click Save and Close at the bottom of the Create window
Instead of closing the edit window, you could also copy the

assignment by clicking Duplicate at the bottom of the
Create window.

Score the new assignment immediately by clicking Score
Assignment in the alert at the top of the window.

\/ Assignment: Unit 1 Test created successfully.

X

To duplicate an assignment for use in another class:

1.
2.
3.

Click Grading
Select Assignment List

In the list of assignments, locate an assignment that you've
already created and click the Edit icon

Click Duplicate at the bottom of the Edit window

Open the Select Classes menu, clear the check box next to
the currently selected class, and choose a different class
Click outside the Select Classes menu to close it.

Edit the duplicated assignment name by deleting the
underscore and number that were appended to the end

Use the same category, score type, score entry points, due
date, description, and publication settings as the original
assignment, or modify the values as needed

8. Click the Standards tab

9. Click Add/Edit Standards and, if needed, select a new set
of standards that are aligned to this assignment

10.To save the assignment and close the Edit window, click
Save and Close

11.To verify that you copied the assignment to a different
class, click the name of the currently selected class in the
navigation bar at the top of the page and select the class
that you copied the assignment to

12. Locate the duplicated assignment in the list of assignments

Copying Assignments

Copy one, some, or all of the existing PowerTeacher Pro
assignments in a selected term and class to other terms and
classes using the Copy Assignments feature. Use the existing due
dates, a custom due date, or proportional due dates relative to the
selected term. Also, copy all of the assignments from a
PowerTeacher Gradebook class to a PowerTeacher Pro class.

If a lock icon appears at the top of the assignment column, the
reporting term or class is locked. You are unable to copy an
assignment to a locked term or class.

To copy assignments from a Semester 1 class to a Semester 2
class:

1. From the Assignments or Scoresheet pages, click the gear
icon to the left of the Term menu

Click Copy Assignments
Under From, open the Term menu and select Semester 1

4. Under From, open the Class menu and select the class from
which you want to copy the assignments

5. Under To, open the Term menu and select Semester 2
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6. Under To, open the Classes menu and select the class or
classes to which you want to copy the assignments

7. Under Copy Options, open the Due Dates menu and choose
whether you want to use existing, relational, or custom due
dates

8. Under Choose the Assignments, check the box to the left of
the Category heading to select all of the assignments, or
check individual boxes next to the assignment names to
choose a smaller selection

If the source class you selected is a PowerTeacher
Gradebook class, all assignments will be copied to the
classes you select.

9. To complete the process, click Copy Assignments

Be sure to edit the due dates of the copied assignments.

Working with Grades

When entering scores, make sure to use the type of score that you
set up when you created the assignment. For example, use
numbers for points and percentages or letters for letter grades.

To enter scores:
1. Click Grading
2. Click Assignment List or Scoresheet

3. From the Assignments or Scoresheet pages, enter a
student’s assignment score by clicking in the cell where the
student’s name intersects with the assignment name and
type in the score

Navigate sideways through the score columns by clicking
the blue columns with left- or right-facing arrows at the end
of the rows.

View the summary above the list of assignments to see the
selected assignment’s score type, as well as the student’s
existing score (if the assignment was previously scored),
and the due date.

In the summary, click Edit Assignment to edit the
assignment details. Click Show More to view additional
information, such as the associated grade and special codes
scales.

Assignment: Problems 11-19 Edit Assignment Show More

Score Type: Points (85) Score:B | 83.53% @ 71/85 Due: 1/14/2017

To view additional metrics for a selected assignment on the
Assighments page, or for all assignments on the Scoresheet page:

1. Click the gear icon at the top of the page

2. Click Show Metrics to view the mean, median, and mode
statistics for the assignments or for the aligned standards

Using the Score Inspector and Flags

While you can enter scores manually, use the Score Inspector to
provide more details about the student’s performance, such as
when a student has a missing or late assignment. Also use the
Score Inspector to enter a comment about a student’s score.

Your district leaders may have associated a special codes scale to
the regular grade scale. If that is the case, you can click Codes in
the Score Inspector and select a special code, such as INC, to
score a student’s assignment. In some cases, you may also see
other system-generated icons that are related to standards grades.

To open the Score Inspector, click in a score cell on the
Assignments or Scoresheet pages.

The following table provides brief explanations of the flags (score
indicators) and other icons available in the gradebook.
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Flag or Icon Description

Indicates that an assignment was collected

Indicates that an assignment is late

Indicates that an assignment is missing

Flag or Icon Description
Indicates that the standard grade is auto-

G calculated from the lower-level standards scores
Indicates that the assignment score is used to
auto-calculate the scores for the standards
aligned to the assignment

Indicates that an assignment is exempt

Indicates that an assignment wasn’t completed
due to the student being absent

Indicates that an assignment is incomplete

Indicates that a comment was added

Indicates that evidence exists for mastery that
may differ from a student’s calculated standard
score

REN[-[ [-I-1:

Filling Scores

Use the Fill functions to either fill scores for one assignment for all
of the students in a class, or to fill all assignment scores for one
student. Scores will be filled in cells that do not already have
scores. Additionally, use the fill scores functions to fill comments.

To fill students’ scores for one assignment:

1. For the selected assignment, click in a score cell on the
Assignments or Scoresheet pages

2. Enter the score or select the flag in the Score Inspector
3. Click the Fill icon with the vertical arrows
4. Save the scores

To fill multiple assignment scores for one student:

1. For the selected student, click in a score cell on the
Assignments or Scoresheet pages

2. Enter the score or select the flag in the Score Inspector
Click the Fill icon with the horizontal arrows

4. Save the scores
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Importing Personal Comments from
PowerTeacher Gradebook

If you used PowerTeacher Gradebook previously, import your
personal comments to PowerTeacher Pro so that you don't have to
create them manually. Keep in mind that you can import
comments only once and only until you create your first
PowerTeacher Pro comment.

If you have already created PowerTeacher Pro comments but would
like to import your PowerTeacher Gradebook comments, delete the
comments you created in PowerTeacher Pro to view the import
option again.

To initiate the import, first click Settings. Then click Comment
Bank. On the Comment Bank page, click Import my PTG
Comments. PowerTeacher Pro comment codes are limited to 10
characters, comment categories are limited to 30 characters, and
the comments are limited to 500 characters. Any PowerTeacher
Gradebook comment exceeding these limitations will be truncated
during the import. If any of your PTG comments exceed the
limitations, you will see a warning. Click Yes to proceed. Once the
import is complete, your personal comments appear on the My
Comments tab of the Comment Bank settings page and are
available for use in the Score Inspector.

Adding Personal Comments to the Comment Bank

Use the Comment Bank settings page to add personal (teacher-
created) comments to the comment bank to use when scoring
assignments or adding final grade comments for report cards. Use
smart text options to include names and pronouns in comments to
personalize the comments for individual students.

Also use the Comment Bank settings page to edit or delete
personal comments, or to identify your favorite personal or district
comments. To mark a comment as a favorite, click the star next to
a comment on either the My Comments or District Comments tab.
Your favorite comments will appear at the top of the list of
comments in the Score Inspector.

To add a personal comment to the comment bank:
1. Click Settings
2. Click Comment Bank
3. On the My Comments tab, click Add
4

Enter a comment code, such as 01

Comment codes are limited to 10 characters.

5. Enter a comment category, such as Study Habits

Comment categories are limited to 30 characters.

6. To mark this comment as one of your favorites, check
Favorite

7. Open the Insert Smart Text menu and choose <first
name> to insert it in the Comment field

8. Enter the rest of the comment after the smart text, such as
consistently completes homework on time
Comments are limited to 500 characters.

9. Click Save
Your personal comment is listed on the Comment Bank

setting page and will appear in the comment bank in the
Score Inspector.
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Entering Comments

As you enter scores or flags for assignments, use comments to
record specific details about student performance. Add comments
manually or choose comments from the comment bank. Click the
star next to a comment in the bank to set it as one of your favorite
comments.

To fill comments, enter a comment for one student and click the
Fill icon. Then choose to fill comments only or to fill scores, flags,
and comments.

When you use the fill functions to fill comments that include the
student’s name or any gender pronouns, PowerTeacher Pro detects
this and you have the choice of applying the smart text to the
comment for each student or using the original text. For example,
if you enter a comment for one student that says, “James
completed all assignment tasks,” fill the comment for other
students, and select Use Smart Text, each student’s name will be
personalized in the resulting comments.

To enter a comment:
1. Click the Comment icon in the Score Inspector

2. Either enter a comment in the text box, or click Show
Comment Bank

3. Click the gear icon and choose either the District Comments
or My Comments bank

Also choose to separate comments by a line break or a
space. Click outside of the menu to close it.

4. Click the + sign next to a comment to select it

A blue Comment icon appears in the student’s score cell.
5. Click Save
6. Click the icon to read the comment

7. Click Clear Comment to remove it from the score

5 (19 GRADE

1. Bailey, Jenilyn B- 82% B A-
2. Brito, Jordan B+ 88% D B
3. Bushman, Joshua A- 92% A A

Scoring Assignments

Use one of two methods to score an assignment—score a single
assignment from the Assignments page, or score multiple
assignments on the Scoresheet.

To enter scores, flags, or comments for a single assignment:

1. Click Grading

2. Select Assignment List

3. Click the name of an assignment

4. Click in a student’s score cell and type a score, such as 72
View the assignment summary above the list of students to
see which score type to use.
Click the Comment icon in the Score Inspector

6. Enter a comment, such as Needs to turn work in on
time

7. Click the right-facing Score arrow in the Score Inspector to
move to a standards score cell (if standards are aligned to
the assignment)

8. Enter a standards score for the student
View the assignment summary above the list of students to
see which grade scale type to use.

9. Save the scores
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To enter scores, flags, or comments for one or more assignments
on the Scoresheet:

1. Click Grading
2. Select Scoresheet

3. Click in a student’s blank score cell for the selected
assignment and enter a score in the Score Inspector

4. Click the vertical Fill icon to fill all of the blank score cells
with the score you entered in the Score Inspector

5. In the alert window that lists the number of scores that
were filled, click Ok

6. Click in a different student’s score cell for a different
assignment and click the Exempt flag

7. Click Save

When you delete or edit a score, a small gear icon appears next to
the values in the student’s Grade column because they are being
edited. Once you save the changes, the student’s grades will be
recalculated using the new score.

Copying Scores and Grades

As a busy teacher, you can sometimes make mistakes like entering
scores for the wrong assignment in your gradebook. Or, you may
have students switch between two classes that you teach. Fix score
entry mistakes or transfer scores by copying and pasting scores or
grades from one assignment to another, or from one class to
another class with the same students in different reporting terms.
Use the Assighments, Scoresheet, or Standards Grades pages to
copy and paste scores or grades. However, keep the following rules
in mind:

e You cannot replace scores or grades that use a different
score type than the original

e When pasted to a column with different grade scales or total
points, scores and grades are not converted to the new
grade scales or total points

e If the list of students is different between the original
assignment scores and the assignment being copied to, only
scores for students who are in both classes will be updated

e You cannot paste into the assignment score column on the
single assignment scoring page when an assignment is set
to auto calculate standard scores

e You are unable to copy scores and grades to a locked term
To copy and paste scores or grades:

1. On the Assignments, Scoresheet, or Standards Grades
pages, click the assignment score column heading

Choose Copy

3. Locate the assignment you wish to paste to and click the
score column header

4. Then choose Paste

All updated scores and grades are highlighted.

5. Save the scores

Exporting and Importing Assignment Scores

When you need to score an assignment offline, such as when you
have a parent volunteer score an assignment, export the
assignment into a spreadsheet. Then record the students' scores in
the spreadsheet and use it to import the scores into PowerTeacher
Pro. If the reporting term or class is locked, you are unable to
import scores.

To export and import assignment scores:
1. Click Grading

2. Select Assignment List
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3. Click the name of the assignment Working with Final Grades

4. In the upper-right corner of the assignment page, click the Final grades are updated automatically throughout the term as you

gear icon enter assignment scores in the gradebook. When the term comes
5. Select Export Scores Template to a close, however, you may have additional tasks to perform
before submitting grades for report cards to make sure that your
If there are any existing assignment scores, choose whether final grades are accurate. For example, you may have to enter
or not to include the scores in the exported file by clicking standards grades, modify individual scores, or enter citizenship
Yes or No in the Export Scores Template window. grades. Occasionally, you may also need to modify a student’s final

grade in a course based on effort, participation, or other

6. Open the exported file performance factors.

The top of the spreadsheet includes the teacher's name, To work with final grades, click Grading and use the links in the
class, assignment name, due date, points possible, extra Grades section. Access the same links through the Quick Menu—
points, and score type. Below the assignment details are the arrow next to the heading at the top of the grading pages.

three columns—Student Number, Student Name, and Score. Grades: Traditional - 52 [

7. Enter the students' scores in the Score column and save the Avens
spreadsheet as a .csv file | radtiona

8. In PowerTeacher Pro, navigate back to the assignment Standards
page, click the gear icon, and select Import Scores Comment Verlfication

9. In the Import Scores window, click Browse Files Category Totals

10. Select the spreadsheet file Al Reporting Terms

11.In the Format menu, use the default selection of

PowerTeacher Score Template To modify a final grade:

12.Check Validate Student Names to verify that the student 1. Click Grading
names in the import file match the names of the students '

enrolled in the class 2. Click Traditional
13. Click Next 3. Click a student’s final grade
) ] 4. In the Score Inspector, edit the student’s grade
Review and correct any import errors.
14.To import and save the scores in PowerTeacher Pro, click For example, change a letter grade of A- to A, and a
Import percentage of 91 to 94.
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5. Click Save

Notice that the student’s final grade cell has a small triangle
in the upper-left corner, which indicates that the grade has
been modified manually.

4
14. MORRIS, Brent A
94%

Open the Quick Menu and select Standards
Click a standards grade for the same student

In the Score Inspector, click the graph icon to open the
view-only standards progress graph for the selected
standard and student

The progress graph shows how the student performed on
the standard over a period of time. Use the arrows in the
Score Inspector to move between progress graphs for the
selected student. To open the student's Standards Progress
page to change assignment scores, you could click Show
More at the top of the graph. Learn more about the
Standards Progress page in the Analyzing Performance
section of this document.

9. Click the graph icon in the Score Inspector again to close
the progress graph

10.0On the Standards page, edit the student's final standards
grade

For example, change a score of 3 to 4 or a score of M to E.
11.Click Save

To revert to the calculated grade, click the Undo icon in the
Score Inspector. To view additional standards metrics, click
the gear icon at the top of the page and then select Show
Metrics to view the mean, median, and mode statistics.

Entering Citizenship Scores

If your school doesn't track behavior through standards, then your
district leaders may enable citizenship score entry and set up a
citizenship scale that includes codes like S for Satisfactory or N for
Needs Improvement for you to use in PowerTeacher Pro.

To enter citizenship scores:
1. Click Grading

2. Click Traditional
3. Click in a student's cell in the Citizenship column
4. In the Score Inspector, select a citizenship score, such as S
5. Click Save
STUDENT (19) Q4 CITIZENSHIP
1. Bailey, Jenilyn B- 82% H
2. Brito, Jordan B+ 88% S
3. Bushman, Joshua A- 92% H

Awarding Variable Credit

If you teach at a school that has an alternative education program
or any sections in which students can earn variable credit hours for
a course, your school administrator can set up PowerSchool so that
you can enter variable credit for students in PowerTeacher Pro.

Using variable credit, teachers can specify how much credit each
student attempted (potential credit) and how much credit each
student is awarded (earned credit), regardless of the credit hours
specified for the course or the grade the student earned for the
class in a term.

To enter awarded and attempted variable credit:
1. Click Grading
2. Click Traditional
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3. Click in a student's cell in the Awarded column
4. Enter the number of credits the student earned, such as .5
5. Click in the same student's cell in the Attempted column
6. Enter the number of credits the student attempted,
such as 1
7. Click Save

Note: If your school's transcripts include only awarded credit, then
you'll see only one column for entering the credit values in
PowerTeacher Pro.

Recalculating Final Grades

Although final grades in PowerTeacher Pro are calculated
automatically, you can force a recalculation, if necessary. Use the
recalculate tool after making significant changes in the gradebook,
such as adding multiple assignment scores for students who
transferred from another class. Also, recalculate grades when your
PowerSchool administrator changes a setting that affects the
gradebook, such as the grade calculation formula, or when you
assign an alternate grade scale to a student.

To use the recalculate tool:
1. Click Grading
2. Select Traditional
Or select Scoresheet, Standards, Comment Verification,
Category Totals, or All Reporting Terms under Grading.

Under Students, click Assignments, Standards Progress, or
Comment Log.

3. Click the gear icon
4. Select Recalculate Final Grades

Select the classes in which you are recalculating grades

6. To recalculate traditional grades, check Traditional Final
Grades

7. To recalculate standards scores, check Standards Final
Grades

8. Click Recalculate

Submitting Final Grades

At the end of the term, notify your school’s PowerSchool
administrator that you have finished entering the scores for the
term and that final grades are ready to be stored.

1. Select a class and verify that you are in the correct term
2. Click Grading

3. Select Traditional

Or select Standards or Comment Verification.
4. At the bottom of the page, click Final Grade Status

5. When you have completed your final grades, check [Term]
Final Grades are Complete

6. Enter a comment indicating that final grades are complete,
and click Save

The green check mark next to "Final Grade Status" indicates
that final grades are complete.

 Final Grade Status

If you aren’t done with final grades yet, leave the check box
clear, enter a status comment, and click Save.
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Understanding Locked Reporting Terms

At the end of a reporting term, your PowerSchool administrator
may choose to lock the reporting term to prevent changes to
grades so that the grades in teachers' gradebooks remain the same
as the grades that have been stored in PowerSchool and included
on report cards. Your PowerSchool administrator will define the
dates on which reporting terms will be locked. Once a reporting
term is locked, you will not be able to change final grades,
assignment scores, or assignments that have been scored.
Additionally, if you recalculate final grades, grades in any locked
terms will not be recalculated.

If your school or district leaders decide to lock reporting terms, you
will see warning messages at the top of PowerTeacher Pro pages,
such as the Assignments and Scoresheet pages.

e Before the reporting term is locked, you will see a warning
message indicating when the reporting term will be locked

For example, you may see a message that says the
reporting term will be locked in five days. Be sure to
complete final grades before the end of the lock date.

e Once a reporting term has been locked, you will see a
message indicating that the term is locked

If you attempt to score an assignment or a standard aligned to an
assignment that has a due date in a locked term, you will also see
a message in the Score Inspector indicating that the score is
locked.

What if you need to correct a final grade after a term is locked? If
you need to change assignment scores or final grades after a
reporting term has been locked, contact your PowerSchool
administrator. Your administrator can temporarily unlock one or
more of your classes so that you can make the necessary changes.

Analyzing Performance

Use the gradebook to analyze student performance at any time
during the school year. Analyze performance throughout the term
to ensure that students are mastering the skills and standards that
you are teaching. Review students’ performance as you prepare to
complete final grades for report cards, and then use the gradebook
to prepare for and conduct parent-teacher conferences.

Review how students in an entire class are performing using the
Progress pages. The individual student pages provide helpful
information during parent-teacher conferences to explain why a
student earned a particular grade.

Student
View Page

Description

Assighments Use the Assignments page to view a summary of a
student’s grades and assignments for the selected
reporting term. The Assignments student page is
similar to the Assignments page you view for the
entire class, except that it shows only the

assignments and scores for the selected student.

Standards
Progress

The Standards Progress page shows a student’s
standards grades by reporting term. The column
that corresponds to the current term is
highlighted. Compare the grades the student
received in each term to assess his or her
progress. To view the assignments that you used
to assess the standard, click the icon in the
Assignments column. Then use the graph at the
top of the page to see how the student performed
over time on the standard.
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Comment Log

Use the Comment Log page to view all of the
comments you've recorded for a student.
Depending on the types of comments you've
entered for the student, the comment log may
show course grade comments, standards grades
comments, and assignment comments.

Demographics

Use the Demographics page to view a student’s
personal information, such as his date of birth or
mother’s phone number.

Quick Lookup
- Traditional

The traditional Quick Lookup page is the same
page that administrators see in PowerSchool. It
shows the student’s attendance for the last two
weeks, his current schedule, his term grades, a
summary of his total absences and tardies, and his
current GPA. Click a grade to see the flags (colored
icons or indicators that represent common
assignment notes like “Late” and “Missing”) for the
student’s assignments and to see the standards
score information. Click the Standards icon to view
the standards aligned to an assignment. Parents,
students, and administrators will also see this
information for all PowerTeacher Pro sections.

Quick Lookup
- Standards

To view a student’s standards Quick Lookup page,
use the Quick Lookup - Standards link. Then click
the arrow next to one of the student’s classes to
view the standards aligned to the course and the
student’s standards final grades. Click a standard
final grade to view details about it.

PowerTeacher
Portal

Use the PowerTeacher Portal link to view the
selected student’s screens in PowerTeacher.
PowerTeacher opens in a new window so that you
don't lose your place in PowerTeacher Pro. The
PowerTeacher screen that appears depends on
which screen you set up to be the default student
screen in PowerTeacher. For example, you may
see the student’s Schedule screen.

Viewing Individual Student Progress

To review an individual student’s performance:

1.

2
3.
4

At the top of the gradebook window, select a class
Click Students
To view the first student’s performance, click Assignments

Review the student’s course grades and individual
assignment scores, then open the Quick Menu and select
Standards Progress

Review the student’s standards scores for each reporting
term, then click the Assignments icon for one of the
standards

Review the graph of standards scores, then click Show
Metrics to review the student’s other standards statistics

= = Calculated : Most Recent 3
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7. Click Students and select a different student to view his or
her Standards Progress page

As outlined in the "Working with Final Grades" section of this
document, you can also view a student's Standards Progress
graphs directly from the Standards page by clicking a student's
standards grade, and then clicking the graph icon in the Score
Inspector. Using the Standards page to view progress graphs is
useful when preparing for report cards.

Here are the definitions of the standards scores statistics that are
visible when you click Show Metrics below the graph:

e Most Recent - The average of the most recent score(s)
e Mean - The mathematical average of the scores

e Median - The middle of the scores (half of the scores are
above this number and half are below)

e Mode - The most common score achieved

e Weighted Mean - The average of the scores based on the
average of total weighted points

e Highest — The highest score

These statistical values are indicators of how well the student did
on a specific standard. If any of the values are low, it may mean

that the student needs additional practice on the skill or concept

that you're assessing, or you may need to revise the assignment.
To view the student’s performance on additional standards, open
the Quick Menu and select a standard.

The orange Professional Judgment Indicator may appear next to a
student’s standard score on the Standards Progress page when
evidence exists for mastery that may differ from the student’s
calculated standard score. To evaluate the student’s level of
mastery, click the Assignments icon next to the standard score.

it  SPEARS, Armstrong - Standards Progress
1(A-B) Calculus
MAT.H.AG Building Functions - (Comment Only)

Grade Scale Type: Numeric (1 - 4)

STANDARDS Q1 Q2 S1 Q3 ASSIGNMENTS

MAT.H.10.AG Graph polynomial functions 2 1+ 2- 2- 6 E

Use your professional judgment to evaluate whether or not the
calculated score is a true indication of the student’s level of
mastery. For example, if the student was ill or had a bad test day,
his last score may not be a true indicator of his skill level, so you
could choose to ignore that score and change the calculated score
from a 2- to a 2.

Graphing Additional Standards or Metrics

To compare a student’s progress on up to four standards:

1. Click the gear icon next to the term menu on the Standards
Progress page

Click Progress Options

In the Progress Options window, select the standards you
want to include in the comparison and click OK

4. Then, click the Show/Hide Graphs icon next to the gear icon
to view the student’s progress on all of the selected
standards

5. Click one of the symbols, such as a triangle, on one of the
line graphs for a different standard to highlight it and view
the scores

6. Below the graph, view the calculated standard grades, the
metrics, the aligned assignments, and the scores for the
standards included in the comparison
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MAT.H.10.AG ~ wad | A1 Kl
Graph polynomial functions

Standards Progress / AYALA, Frank

- G .S S )

8/9 9/10 10/3 10/14 10/27

- = Calculated : Most Recent3 ~ ..... Highest

. Analyzing Class Progress

- - Calculated : Most Recent 3

To analyze the performance of an entire class, begin by selecting
Standard Grade Show Mefrics | 3- A 3+ 3- the class at the top of the gradebook window. Then, click
Progress. Depending on how the gradebook is set up, you can

By default, the Standards Progress graph displays a green dotted view class progress on traditional grades and standards grades.

line that corresponds to the metric, such as Most Recent, used in Viewing Traditional Grades Progress

the standards grade calculation. _ o
. ) To view traditional grades progress:
To add additional metrics to the graph: .
1. From the Progress menu, select Traditional

1. Click the gear icon next to the term menu on the Standards
Progress page The graph on the Traditional Grades Progress page shows
the distribution of grades for the class for the selected

Click Progress Options
reporting term. Click the information (i) icon to view the

3. Inthe Pr(I)Igress Options window, open the "Addi_tional Metric traditional grades included in each color level. To the right
To Graph" menu and select a metric, such as Highest of the graph, view a summary of the total number of
4. Click OK students who have missing, late, or incomplete

assignments.

A gray dotted line appears on the graph, indicating the
score that corresponds to the selected metric.
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1st Grade English (52)

- ®

) o 4 =
L ] 21 L
5 O ate

8 g
3
' m 4 @ Incomplete

4 @

@ View All

Click View All to open the Traditional Grades Distribution
window

On the left side of the Traditional Grades Distribution
window, view the grade distribution for each reporting term
in the school year

On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
grade is trending down between the selected terms. A green
arrow indicates an upward trend, while no arrow indicates
no change. You can see which students are performing
better or worse between terms.

. To compare trends between a different selection of
subsequent terms, click a term in the Grade Distribution
column

Click the information (i) icon to view the grades included in
each color level

7. To close the window, click X in the upper-right corner

Traditional Grades Distribution E

{ E 1st Grade English

Class grade trends in S2 compared against S1.

Ql
Q2

s1

|52

Viewing Standards Grades Progress

GRADE DISTRIBUTION

STUDENTS

HAWKINS, Kendra
PORTER, Simpson
SHERMAN, Cliff
HARRIS, Olivia

GRADE

IRl

COOLEY, Sanders
GATES, Hart

KELLY, Washington
COX, Gustavo
OLIVER, Wyona
SELLERS, Garcia
HERNANDEZ, Linda
HANSEN, Robert
MCDANIEL, Moore
LI, Jimi

GATES, Bethany
CONTRERAS, Amanda
CAMPBELL, Butler
BLACK, Perisa

BISHOR, Donovan

To view standards grades progress:

w oo o o o PP @ @

PR OR®EH |© EBRBERIVE®

1. From the Progress menu, select Standards

OK

The graph on the Standards Progress page shows the
distribution of grades for each standard aligned to the
course, for the selected class and reporting term.
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Calculus

STANDARDS GRADE DISTRIBUTION (Q3) ASSIGNMENTS
MAT.H.10.AG - Graph polynomial functions 22 3 2 6 E
MAT.H.11.AG - (+) Graph rational functions 23 2 o 5 E
MAT.H.12.AG - Graph exponential and logarithmic functions 22 3 ) 4 E
MAT.}!.IS.AG - (+) Represent a system of linear equations as a single matrix 24 1 ) 4 E
equation

MAT.H.16.AG - (+) Find inverse of a matrix and use it to solve systems of 20 5 ) 4 E

linear equations

2. Click the graph to open the Standard Grades Distribution
window

3. On the left side of the Standard Grades Distribution window,
view the grade distribution for the selected standard for
each reporting term in the school year

4. On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
level of mastery is trending down between the selected
terms. A green arrow indicates an upward trend, while no
arrow indicates no change.

5. To compare trends between a different selection of
subsequent terms, click a term in the Grade Distribution
column

6. To close the window, click X in the upper-right corner

Standard Grades Distribution £ | x

E Calculus

MAT.H.15.AG - (+) Represent a system of linear equations as a single matrix equation
Standard grade trends in Q3 compared against Q2.

GRADE

GRADE DISTRIBUTION STUDENTS
at 23 2 | SLOAN, Matt F 4 D
Q2 24 1 RANDOLPH, Frank C 4 B-
SPEARS, Armstrong C A B-
s1 24 1
KAISER, Harvey C+ 1 Cc
WADE, Ortiz C+ 4 B-
Q4 0 0
NOVAK, Layla B- T C+
s2 24 1 POOLE, Brent B- B-
v1 24 1 POTTER, Romy B- B-
BAILEY, MacDonald B- , C+
CASE, Shaniqua B i C

On the right side of the Standards Progress page, the number in
the Assignments column indicates the number of assignments that
you've used to give students opportunities to practice the standard
or to assess their levels of mastery.

To view the assignments aligned to a standard:

1. Click the Assignments icon next to a standard

STANDARDS GRADE DISTRIBUTION (Q3) ASSIGNMENTS

4 | s B

MAT.H.10.AG - Graph polynomial functions 21
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2. On the Standards Assignment Trend window, click the name
of an assignment

3. If needed, edit students’ scores in the column for the
selected standard and save the scores

Running PowerTeacher Pro Reports

The gradebook contains reports that you can view onscreen or
print. Personalize each report by entering a custom title or by
including a top note, bottom note, or signature line. The following
table provides brief descriptions of the reports:

Report Name

Description

Multi-Function
Assignment Report

Use this report to view or print a
list of students and scores per
assignment

Use it to find missing, late, or
incomplete assignments, to help
students and parents keep up with
class work, to target students who
need extra help, or to gauge
which assignments present the
most challenges to students

Report Name Description

Individual Student e Use this report to view or print a

Report summary of the class activity per
student

e Include only one class or the
student's full schedule

e Include student numbers next to
student names for identification
purposes

e Present a summary of student
work to parents at conferences or
to a principal during a review, or
use the report as a midterm
update for students and parents

e Choose whether or not to include
course grades and attendance,
assignments, category totals,
standards scores, citizenship
scores, and comments

e Print the report for a few students
or a group

Scoresheet Report

Use this report to print a copy of
the Scoresheet page

Include final grades and
assignment scores

Use student numbers or names

Sort students by name, student
number, or randomly

Use it to post a printout of
students' grades

Run the report as a PDF or an
Excel spreadsheet
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Report Name

Description

Student Roster .

Use this report to view or print
demographic information by class

e Use the report, for example, to
keep track of money collected for
classroom field trips, or as an
emergency contact list

e Customize the report by adding
blank columns (the report
remembers the information you
entered last)

e Use the Order arrows to arrange
the columns in any order

e Run the report as a PDF or an
Excel spreadsheet

To run the Individual Student Report:

1.

2
3.
4

Click Reports
Select Individual Student Report
Enter a report title, such as Progress Report

Open the Select Classes menu and choose the classes to
include on the report

To use a previously customized class name, check Use
Custom Class Name

Since you are creating a progress report that includes
students' course grades in only your class instead of all of
their classes, leave the "Include Students' Full Schedules"
check box clear

Check Include Students' Full Schedules to create a
multi-section report.

10.

11.
12.

13.

14.

15.

16.

In the Sort Options section, open the Layout menu and
choose By Section, By Student

To sort the report by students’ last names, open the
Students menu and choose Last Name

To use the preference for how student names are sorted by
default in your gradebook that you defined under Settings >
Display Settings, choose Gradebook Preference.

Use the Assignments menu to sort the assignments by due
date or by category and due date

Open the Areas To Include menu and check Course Grade
Comments and Assighment Comments to include any
comments that you’ve entered about the students in the
report

"Course Grades and Attendance," Assignments, and
Category Totals are checked by default. If citizenship score
entry is enabled, select Citizenship to include citizenship
scores.

Click the Areas To Include menu again to close it

Verify that Show Percentages is selected to include
students’ grade percentages in the report

To help with identifying students with the same name, add
student numbers to the report by selecting Include
Student Number with Student Name

To include students’ grades from the current term, use the
default settings under Date Range

Use the default settings under Data Filters to include any
assignments, any scores, any category, and any course
grades

Open the Students tab
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17.To run the report for a selection of students rather than for
all of the students in the classes, click Add/Remove
Students

18. All of the students are selected by default, so clear the
check box to the right of the Filter area, then in the list of
students, check the boxes next to individual student’s
names

19. Scroll to the top of the page and click the Format tab

20.Since you are including all of the available data in the
report, leave the page orientation set to Landscape to
make the text easier to read

21.Use the default option PDF for the report output

22.To create a page break between students, check Page
Break

23.Choose to exclude row shading to save ink during printing

24.Leave the “Include” check box clear for the Top Note option,
since you don't plan to include a note at the top of the
report

25. Leave the “Include” check box clear for the Bottom Note
option, since you don‘t plan to include a note at the bottom
of the report

26. Clear the Signature Line check box, since you don't need
parents to sign the report

27.To generate the report, click Run Report

Progress Report AGUILAR, Sprik

Class: 2(A-B) Trigonometry Teacher: Hicks

Final Grade

Rpt. Term Grade Percent Absent Tardy Missing Late Incomplete
a1 c 74.52%

Assignment Scores

Date Category Assignment Score | Pts

Poss

% Grade Flags Comment

10/29/2016 | Test Muttiplication Practice 2 70 100 70% C

1027/2016 | Group Project | RS Pg 111-115 70 Co

To run the Student Roster report for a class:

1.

u »h W N

10.
11.

12.

13.
14.
15.

16.

Open the menu at the top of the gradebook window and
select a class

Click Reports
Select Student Roster
Enter a report title, such as Field Trip Roster

Since you selected a class before you navigated to the
Reports menu, it is already selected for the Classes option

To sort the roster of students by last name, open the
Students menu and choose Last Name

Add columns of student information by opening the Add
Columns menu and clicking Add next to Gender and Grade
Level

Click Add next to Blank twice to include a column for taking
attendance and one for tracking participation

A column titled "Name” is included by default to list the
students’ names.

Click the Add Columns menu again to close it

Enter Attendance as the title of the first blank column

Enter Participation as the title of the second blank
column

Click the Students tab at the top of the page and verify that
the report applies to all of the students in the selected class

Scroll to the top of the page and click the Format tab
Open the Orientation menu and choose Portrait

Use the default option PDF for the report output

To work with the data in a spreadsheet, choose Excel.

Use the default settings for the rest of the format options
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17.To generate the report, click Run Report

Field Trip

Name Gender Grade Attendance Participation
AYALA, Frank M 12

BAILEY, MacDonald
BERGER, Harvey
CASE, Shaniqua
CASEY, Headroom
CLINE, Matt

COBB, Hunter

m m 2 M m 2 =Z
N

FRIEDMAN, Bennet
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